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angie taylor
character animation
I’ve done a fair bit of character animation using After Effects, mainly cut-out animation, similar to the 

style Terry Gilliam used in the Monty Python animations and not too dissimilar to South Park’s style of 

animation.

Till Parenting was introduced, I always used complex nesting procedures to link the individual parts of 

my characters together. I would draw them in Illustrator with each part on a separate layer, bring it in as 

a Comp and then Pre-comp the body parts together as needed.

Parenting gets rid of the need for complex nesting hierarchies, I can now link the body parts together in 

one composition. Needless to say I spend far less money on headache pills now! I know that it may seem 

intimidating to those who have never used it before but Parenting really makes life so much simpler.

01  Open the project named Character_anim.aep from the Character animation folder.

02  Use the Period key (.) and the Comma key (,) to adjust the magnifi cation of your comp till you are happy 

with it. Use the Hand tool (H) to move the viewable image around inside the Comp window. Hit the V key 

to select the selection tool when you are happy.

OK, the fi rst thing that we have to do is to set up our Pivot Points, i. e. the point around which we want 

our layers to rotate. After effects uses the Anchor Point of a layer as its pivot point. When you import an 

image or movie, the anchor point is positioned in the centre of each layer.

03  Select the Rotation Tool w from the Tool Palette and then select the 

T-shirt layer and rotate it, notice it rotates around the centre of the layer.

04  Undo the Rotation of the layer till you are back to where you started.

05  Select the Pan Behind Tool y from the Tool Palette. The Pan Behind Tool 

can be used to adjust the Anchor Point without altering the layout you 

already have in the Composition window.

06  With the Pan Behind Tool, click and drag the Anchor Point of the T-shirt 

Layer till it sits in the middle of the characters hips, where you would expect 

the body to rotate from.
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07  Hit the r key to bring up Rotation value and scrub the 

value. Now it rotates around the correct point. 

08  Undo the rotation and reselect the Selection tool v 

when you have fi nished.

09  Repeat this process for the Arm layers and the head 

layer, make sure that you move the Anchor Point to 

the position you would expect them to rotate from. 

The arms would rotate around the elbows, the head 

around the neck. I have circled the appropriate areas in 

the diagram below, get as close as you can to this as 

possible.

OK, so what we need to do now is to link the limbs 

and head to the main body of the character. In this 

case, the legs are staying still so all we need to do is 

make the T-shirt layer a parent for the head and arms. 

Let’s start with the arms.

10  Make sure that the Parenting column is visible. If not, 

click on the timeline’s wing menu and then go to 

Column>Parent.

11  Drag the Pickwhip from the Right Arm layer onto the 

T-shirt layer. Let go of the mouse button/ Pen when 

the T-shirt layer is highlighted and the Parenting menu 

changes to display the name of the T-shirt layer.

12  Repeat this process for the Left-arm layer.

13  Once you have fi nished setting up 

the parenting, select the T-shirt 

layer again and rotate it, now the 

arms rotate along with the T-shirt 

when it moves. 

  

We also want to Parent the head to the T-shirt but there is a good reason why we are not doing so 

yet, we want to create some animation on the head before we parent it to the T-shirt layer.

14  Try rotating the arms and head a little, notice that they rotate independently from the head.

15  Undo the rotations so that your character is in its original pose.

OK, we’re going to start to animate this character now. I want the characters to be dancing in time with 

the music. There are several methods of making layers move in time with music, you can use Layer 

Markers to mark beats, or you can use the Convert Audio to Keyframes Animation Assistant to automate 

the process. There is one more method which is fantastic for recording any sort of motion whether it be 

timed with music or not and that is the Motion Sketch palette.
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basic motion capture
The Motion Sketch palette is available in both Standard and Professional versions of After Effects. 

It allows you to capture any motion you make with your input device, this can be a Mouse or a Graphics 

tablet and Pen. I fi nd it much easier to use Motion Sketch with my trusty Wacom tablet rather than a 

mouse which can be quite cumbersome to move around. If you have never used a graphics tablet before 

I thoroughly recommend investing in one, they are much easier and more creatively fl exible to use than a 

mouse. They take a little time to adjust to and once you’ve started using one, you never want to go back.

My tablets of choice are the Wacom Intuos range, you can fi nd information the Wacom website at:

http://www.wacom.de

01  Using the Motion Sketch palette can take a wee bit of getting used to, so before we move on I want you 

to increment and save this project (File>Increment and Save). This will save a new copy of your project.

Remember that you have just saved the project so you can practice the fi rst 

step till you feel comfortable, if, at any point you get into a muddle with the 

Motion Sketch palette,  simply go to File > Revert at any point to take you 

back to this stage. 

02  With the Head layer selected, go to Window > Motion Sketch 

to bring up the Motion Sketch palette.

OK, I don’t want you to follow these steps yet, just read through the next couple of paragraphs so that 

you are aware of what the process is. You may need a fair bit of practice before getting this absolutely 

right but don’t give up, repetition is the best method for improving your techniques.

To use Motion Sketch the fi rst step is to click once on the Start Capture button in the Motion Sketch 

palette to let it know that you want to capture some motion. With the button clicked, After Effects 

will not begin to capture the motion until you click again at the point where you wish to begin your 

animation. As soon as you click the mouse or pen again, anywhere on the screen, After Effects will start 

to record the motion, it will stop recording when you release the mouse button or lift the pen from the 

Tablet.

When you do start recording the motion you want to create a fairly small amount of movement, mainly 

on the X-axis (left to right), where the main beats occur. 

03  First of all, I want you to make sure that the Head layer is selected and then click once on the Start 

Capture button to activate the Motion Sketch palette.

04  Move your pen or mouse over the Comp window, taking care not to accidentally click the mouse button or 

touch the graphics tablet as you do. Position the cursor where you would like to start the motion capture 

from.

05  When you are ready, click the mouse button or pen and hold till you hear the music start to play, as soon 

as you do, start to move the mouse/ pen from side to side in time with the music. Don’t move it too far, 

just a little distance from the original point. When you have fi nished you can fi ne tune the position of the 

head by adjusting the anchor point value, this will not affect the position keyframes.
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06  Once you are happy with it, drag the Pickwhip from the Parent column of the Head layer onto the T-shirt 

layer to make the T-shirt the Parent of the Head layer. The reason that we waited to do this after the 

motion sketch is to keep the captured motion unaffected by the Position values from the parent.

The head now moves independently from the T-shirt layer (its parent) yet if you try rotating the T-shirt 

layer, you’ll fi nd that the Head moves with it wherever it goes.

using expressions to link the body parts
We have linked the body parts and captured some movement for the head using the Motion Sketch 

palette. Now we’ll create some expressions that will animate the other body parts just by using the Head’s 

position values. You should have a basic understanding of expressions before attempting this exercise.

01  Select the Right Arm layer and hit r view the rotation values. Select the Head layer and hit p to see the 

Position values. These are the keyframes we created using the Motion Sketch palette. 

02  RAM Preview the Elliss.psd comp to remind yourself of what we’ve done so far. 

We’ll now use expressions to take the Head movement to the other body parts to make him dance in time 

with the music. Remember we concentrated on making most of the Head’s movement happen along the 

X-axis, so this is the best place to take the movement from.

03  Alt-click the Rotation property stopwatch of the Right Arm layer to add an Expression, then drag the 

pickwhip on to the fi rst (X) value of the Head layer’s Position values.

04  Activate the expression by clicking outside the text fi eld or hitting Enter on the number pad. The 

expression will read:

thisComp.layer(“Head”).position[0]

With this, we’re telling After Effects to take the Right Arm’s Rotation value from the X Position value 

(represented by [0]) of the Head layer within this comp.

05  Shift+RAM Preview the composition. The Right Arm is now rotating with the same timing as the Head’s X 

movement. But it’s not really moving enough and the movement looks very odd.
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06  In the Expression text fi eld, place the cursor after the current expression text and add:  *5 so that the 

expression reads:

this_comp.layer(“Head”).position[0] *5

This will multiply the resulting values by fi ve, making the rotation a lot more exaggerated. But the arm is 

bending back in a most unnatural way, so we just need to nudge the rotation a little to compensate.

  

Your values will not be exactly the same as mine so you may need to adjust the numbers slightly to 

get the results you want.

07  Place the cursor after the current expression text and add:   –150 It should now read:

this_comp.layer(“Head”).position[0] *5 –150

08  Activate the expression and RAM Preview the results so far. While the amount of motion stays the same, 

all the rotation values throughout the animation will now be 150° less than they were before.

09  Multiplying and dividing the values causes big changes in the amount of motion, while adding and 

subtracting will just offset the result by a set amount.

OK, what about if we want the head to scale up and down as it is moving? This would give us a bit of 

depth, making it appear that the head was jutting forwards and backwards as well as from side to side.

10  Select the Head layer and hit S+s to view the Scale value alongside the Position value.

11  A-click the Scale stopwatch to add an expression, then drag the Pick Whip over to the second Position 

value (the Y value) on the Head layer.

12  Activate the expression. It should read:

temp = position[1];

[temp, temp]
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This makes the word ‘temp’ a variable representing 

Position [1] and then the second line says;

“take both the X and Y Scale values from this layer’s Y 

Position value (represented by the word temp). In this case, 

there’s no need for it to specify the layer name because the 

Position property is on the same layer as the expression.

13  Immediately, you’ll notice that the Head layer is now far too 

small for the body. No problem, we’ll simply add 25 to the 

Scale value, right? 

14  OK, try placing the insertion point after the current 

expression text and type in; + 25 

15  Activate the expression and you’ll see that only the X value 

has been affected by the arithmetic. 

The reason for the error is because the scale property 

contains two values whilst the four main math symbols(+ 

– * / ) can only be used to perform arithmetic on single 

values. After Effects needs separate instructions for each 

value within the brackets. 

There are two possible solutions for this, both are useful, 

which one you choose will depend on the situation. 

The fi rst is to adjust each axis individually. 

This is useful in cases where you want the X and Y values to be different from each other.

16  Highlight the text fi eld in the Expression and change the line of text so that it reads like this:

temp = position[1];

[temp+25, temp+25]

Now the expression is adding the same value to each of the X and Y Scale values individually before 

packaging them back together. Using this method you can choose to apply different arithmetic on each 

axis.

17  Change the expression so that it reads;

temp = position[1];

[temp+25, temp+100]

Now the expression is adding different values to each of the X and Y Scale values individually before 

packaging them back together. The second method of adjusting the result of this expression is to use one 

single calculation on the fi rst line of the expression. This is useful in cases where you want the aspect 

ratio to always be maintained.

18  Change the expression so that it reads;    temp = position[1]+25;

                [temp, temp]
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Now the expression is adding a single value to the value represented by the word ‘temp’ before applying 

it to the X and Y Scale values and packaging them back together. Using this method you are still free to 

perform further arithmetic on the individual values in square brackets.

19  Hit Enter on the number pad and then RAM Preview the comp again. The head is much more of a 

reasonable size now.

We can take this much further. Let’s animate the Left Arm layer, but instead of rotating it we’ll scale it up 

and down, to make it look as if it’s punching in and out.

20  Select the Left Arm layer and hit the s key to view the Scale property.

21  A-click the Scale stopwatch to add an expression, then drag the Pick Whip over to the fi rst Position 

value (the X value) on the Head layer. You should come up with this expression;

temp = thisComp.layer(“Head”).position[0];

[temp, temp]

The this_comp.layer(“Head”) is there because the expression is reading a value from a different layer. But 

basically it’s much like our last expression, saying, ‘make both the X and Y Scale values the same as Head 

layer’s X Position value’.

22  Activate the expression and RAM Preview the result.

23  We can see that the left arm is far too big now; we’ll use some more arithmetic to reduce both the scale 

values by 40.

24  Adapt the existing expression so it reads:

temp = thisComp.layer(“Head”).position[0]-40;

[temp, temp]
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OK, let’s animate the T-shirt layer.  Remember that we used the T-shirt as a parent for the arms and head, 

so wherever we move the T-shirt, those layers will follow.

25  Select the T-shirt layer and press R to see its Rotation property.

26  Alt-click the Rotation stopwatch to add an expression, then use the Pick Whip to select the X value from 

the Head layer’s Position. The resulting expression is:

this_comp.layer(“Head”).position[0]

27  Activate the expression and you’ll see the T-shirt layer’s 

rotation needs to be corrected, it’s upside down at the 

moment.

28  Adapt the expression by placing  –170  after it, so it 

reads:

this_comp.layer(“Head”).position[0] –170

29  Activate the expression and RAM Preview the result. 

It’s looking pretty good. However, I really wanted the T-

shirt to rotate in the opposite direction to the Right Arm 

layer.

A quick way for us to fl ip the Rotation values is to multiply them by minus one. This will make positive 

values negative and negative values positive. For example we could modify it like this:

this_comp.layer(“Head”).position[0] –170 * –1

Now, even though we’ve done this already, it isn’t really a good idea to keep placing one calculation after 

another to adjust the result of an expression. We end up having to do lots of calculations in our heads to 

fi gure out what’s going on. It’s better practice to break each stage of the process up; this will allow us to 

perform complex calculations while still keeping the expression relatively simple to understand. We can 

use variables to simplify the whole thing.

Up till now we’ve used the word temp as our variable, this is the default word used by After Effects when 

a variable is required. But you can use any word as a variable, you can even use single characters as 

variables, such as a, b or c.

30  As this is the Ellis Animation, I’m going to use the variable ellis in the expression.

31  Change the T-Shirt layer’s Rotation expression so that it reads:

ellis = this_comp.layer(“Head”).position[0] –170

32  Now place the cursor at the end of the text  and add a semi-colon ( ; ). When you have expressions that 

are made up of multiple lines, you must end each of those lines with a semi-colon for it to be recognized.

33  Add a new line to the expression by pressing the main Return key on your keyboard. You’ll see the 

expression text fi eld automatically expands to show another line.
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34  Enter ellis * –1;   on the second line, so that the entire expression reads:

ellis = this_comp.layer(“Head”).position[0] –170;

ellis * –1;

35  The fi rst line of the expression is subtracting 170  from the X value of the Head layer’s Position and 

assigning the resulting value to the variable ellis.

36  The second line is then taking that resulting value (now represented by the word ellis) and multiplying it by 

minus one.

37  Activate the expression and  RAM Preview to check out the fi nal result. Ellis is now doing a simple little 

dance in time with the music.

38  Save the project into your Character animation folder. 

Once you are comfortable with expressions and have exhausted the techniques used in this tutorial, 

you can learn to use the Linear and Ease expressions to convert one range of values to another 

instead of using basic arithmetic. Instructions on this can be found in the Expressions chapter of the 

forthcoming new edition of my Creative After Effects book. Please keep an eye on my website for further 

announcements.


